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Dieses Dokument unterliegt dem Copyright © 2010–2024. Die Beitragenden sind unten 
aufgeführt. Sie dürfen dieses Dokument unter den Bedingungen der GNU General Public 
License (http://www.gnu.org/licenses/gpl.html), Version 3 oder höher oder der Creative 
Commons Attribution License (https://creativecommons.org/licenses/by/4.0/) Version 4.0 
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Angaben, die in diesem Buch verwendet werden, sind als eingetragene Marken geschützt.
Da es nicht möglich ist, in allen Fällen zeitnah zu ermitteln, ob ein Markenschutz besteht, 
wird das Symbol (R) in diesem Buch nicht verwendet.
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Rückmeldung
Kommentare oder Vorschläge zu diesem Dokument können Sie in deutscher Sprache an die 
Adresse discuss@de.libreoffice.org senden.

Vorsicht

Alles, was an eine Mailingliste geschickt wird, inklusive der E-Mail-Adresse und 
anderer persönlicher Daten, die die E-Mail enthält, wird öffentlich archiviert und 
kann nicht gelöscht werden. Also, schreiben Sie bitte mit Bedacht!

Datum der Veröffentlichung und Softwareversion
Veröffentlicht am 26.11.2024. Basierend auf der LibreOffice Version 24.8 Community.
Andere Versionen von LibreOffice können sich im Aussehen und der Funktion unterscheiden.

Verwendung von LibreOffice unter macOS
Einige Tastenbelegungen und Menüeinträge unterscheiden sich zwischen der Macintosh-
Version und denen für Windows- und Linux-Rechner. Die unten stehende Tabelle gibt Ihnen 
einige grundlegende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der 
Hilfe der jeweiligen Komponente.

In Windows/Linux entspricht unter macOS Effekt
Menü
Extras > Optionen LibreOffice > Einstellungen Zugriff auf die Programmoptionen

Rechtsklick Ctrl+Klick und/oder Rechts-
klick je nach Einstellungen Öffnen eines Kontextmenüs

Strg (Steuerung) ⌘ (Command) Tastenkürzel in Verbindung mit 
anderen Tasten

Alt ⌥ und/oder Alt oder Option Tastenkürzel in Verbindung mit 
anderen Tasten

F11 ⌘+T Öffnen der Formatvorlagen in der 
Seitenleiste
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Synonyme
In diesem Dokument verwendete Synonyme:

für
Abschnitt
Anfasser (Punkte am Ende einer Symbolleiste)
Deck
Dialogfeld, Dialogbox
Dropdown-
Menüleiste, Hauptmenü,
Objektpunkte (quadratisch, rund, oval)
Popup-Menü
Register, Reiter
Tabulator
Tooltip

in diesem Dokument verwendet
Bereich
Griff(e)
Bereich
Dialog
Auswahl-
Menü
Ziehpunkte
Menü
Tab
Tabulator
Direkt Hilfe

Viele Begriffe im Bezug zu LibreOffice und den darin verwendeten Techniken finden Sie im 
Glossar. Das Handbuch Glossar wurde für alle Komponenten von LibreOffice erstellt und 
kann im Bereich „Erste Schritte  ganz unten heruntergeladen werden.‟

Sie sehen vielleicht etwas anderes
LibreOffice läuft auf Windows, Linux, Mac OS X, FreeBSD und anderen Unix-Varianten, von 
denen jedes Betriebssystem unterschiedliche Versionen hat und kann von den Nutzern 
bezüglich Schriftarten, Farben und Themen angepasst werden.
Die Bilder in diesem Handbuch wurden mit hellem Thema in Windows 10 erstellt. Das 
LibreOffice Thema entspricht der Werkseinstellungen.

Querverweise hier im Dokument
Anklickbare Querverweise hier im Quell-Dokument (.odt) sehen Sie grau hervorgehoben, 
wenn Sie den Umschalter im Menü Ansicht > Feldhinterlegungen (Strg+F8) einschalten.

Links zu externen Quellen
Anklickbare Links zu externen Quellen werden wie folgt dargestellt:
LibreOffice – Startseite
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Einführung
Draw verwendet für die Arbeit mit Dokumenten Standardeinstellungen, die Sie aber in vielen 
Fällen beeinflussen können. Wählen Sie dazu das Menü Extras > Optionen… und öffnen Sie 
den Teilbaum LibreOffice Draw durch Anklicken des Knoten-Symbols oder mit der Pfeil-
Taste Nach-Rechts. Die Optionen für Draw werden in den vier Unterpunkten dieses 
Teilbaums angeboten Diese vier Optionsgruppen werden in den folgenden Abschnitten 
näher beschrieben  (siehe Abbildung 1, links).

Abbildung 1: Dialog Optionen - LibreOffice Draw - Allgemein

Daneben gibt es auch noch eine Symbolleiste Optionen (siehe Seite 23), deren einzelne 
Optionen teilweise mit einigen aus diesen vier Unterdialogen oder aus Menüs identisch sind, 
teilweise sind aber auch solche enthalten, die dort nicht verfügbar sind. Abbildung 18 (auf 
Seite 23) zeigt die Optionen dieser Symbolleiste (dargestellt über deren Kontextmenü Sicht-
bare Schaltflächen) und daneben die Aufstellung, wo sich die Optionen finden lassen.
Es kann auch nützlich sein, eine Option temporär zu ändern, um gewisse Aktionen zu 
erleichtern.
Ziemlich am Ende des Dokuments stehen auch folgende Hilfen als Screenshot der Benutzer-
oberfläche mit Legende von Draw zur Verfügung:
Startbildschirm auf Seite 21
Seitenleiste auf Seite 22
Symbolleiste Optionen auf Seite 23
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Die Optionen zur Objektbearbeitung
Es gibt mehrere Optionen, mit denen Sie beeinflussen können, wie Sie am einfachsten die 
verschiedenen Aspekte eines Objekts bearbeiten können. Diese Optionen werden zunächst in 
diesem Abschnitt behandelt, bevor dann die vier Dialoge von Extras > Optionen… und die 
Symbolleiste Optionen im Einzelnen dargestellt werden.

Für Textobjekte

Abbildung 2: Symbolleiste Optionen - Sichtbare Schaltflächen – auch zu erreichen über...

Dafür gibt es zwei Optionen:

Schnellbearbeitung
Wenn die Schnellbearbeitung zugelassen ist (im Dialog Abbildung 1 auf Seite 7 oder in der  
Symbolleiste Abbildung 2), dann gelangen Sie direkt in den Textmodus, in dem Sie einen 
vorhandenen Text ändern können. Klicken Sie den Text eines Objekts direkt an. Klicken Sie 
dagegen außerhalb des Textes in das Objekt, dann wird das Objekt selbst ausgewählt, so 
dass Sie dieses bearbeiten können.
Ist die Schnellbearbeitung nicht zugelassen, dann müssen Sie, nachdem Sie das Objekt 
ausgewählt haben, den Textmodus erst aktivieren über:

• einen Doppelklick irgendwo in das Objekt
• durch Aktivieren des Symbols Textfeld und klicken in den Text
• das Menü Einfügen > Textfeld und klicken in den Text
• durch die Taste F2  und klicken in den Text.

Mit den letzten drei genannten Varianten  können Sie alternativ mit der Maus ein Textfeld 
aufziehen, in das Sie den Text schreiben können.
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Text bearbeiten bei Doppelklick
Wenn diese Option aktiv ist (was der Standard ist), gelangen Sie durch einen Doppelklick auf 
ein Objekt in den Textmodus andernfalls, müssen Sie wiederum auf eine der drei letzten 
Möglichkeiten zurückgreifen, die im vorigen Abschnitt Schnellbearbeitung (oberhalb) aufge-
führt sind.

Hinweis

Unabhängig von der Einstellung dieser Optionen gelangen Sie in den Textmodus, 
wenn sie ein Zeichnungsobjekt ausgewählt haben und dann Text tippen; er wird 
dann allerdings immer an den eventuell vorhandenen Text angehängt.

Drehmodus
Man versetzt ein bereits ausgewähltes Objekt in den Drehmodus, indem man das entspre-
chende Symbol in der Symbolleiste Standard oder Optionen anklickt oder das Menü Form > 
Verändern > Drehen auswählt.
Wenn Sie häufig Objekte drehen wollen, können Sie den Weg in den Drehmodus erleichtern, 
indem Sie in der Symbolleiste Optionen das Symbol Drehmodus aktivieren. Dann versetzt ein 
Klick auf ein bereits ausgewähltes Objekt dieses in den Drehmodus, Sie müssen dazu nicht 
erst zur Symbolleiste Standard wechseln.

Optionen - Allgemein
Diese Optionen sehen Sie in Abbildung 1 auf Seite 7.

Einstellungen

Kopie beim Verschieben
Wenn diese Einstellung aktiv ist (siehe Abbildung 1 auf Seite 7), wird beim Verschieben eines 
(ausgewählten) Objekts eine Kopie erzeugt, sofern dabei die Strg-Taste gedrückt wird. Dies 
gilt ebenso, wenn das Objekt im Drehmodus ist.

Hintergrundzwischenspeicher verwenden
Für die Anzeige von Objekten auf der Masterfolie wird der Arbeitsspeicher verwendet (siehe 
Auswahl in Abbildung 1 auf Seite 7). Dadurch wird der Bildschirmaufbau beschleunigt. Wenn 
die Änderungen am Inhalt auf der Masterfolie sichtbar sein sollen, deaktivieren Sie diese 
Option.

Objekte immer verschiebbar
Mit dieser Einstellung, (siehe Auswahl in Abbildung 1 auf Seite 7), können Sie die Arbeit im 
gerade bevorzugt von Ihnen benötigten Modus erleichtern:

• Ist diese Einstellung aktiviert, dann kann ein Objekt auch verschoben werden, wenn 
der Drehmodus aktiv ist. Aber Vorsicht, der mittige Drehpunkt wird nicht mit verscho-
ben. Drehen geht nur, wenn an den Drehpunkten angefasst wird.
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• Andernfalls ist das Verschieben im Drehmodus blockiert (außer Strg+ziehen), statt-
dessen wird das Objekt auch dann gedreht, wenn Sie es außerhalb der Drehpunkte 
anfassen. Dies gilt allerdings nur, wenn Sie sofort nach dem Klicken die Maus 
bewegen; wenn Sie dagegen einen Moment warten, ändert sich der Mauszeiger zu 
einem Pfeil mit einem angehängten Rechteck, dann können Sie das Objekt trotzdem 
verschieben.

Objekte in Kurven nicht verzerren
Diese Option, (siehe Auswahl in Abbildung 1 auf Seite 7), bezieht sich auf das Menü Ansicht > 
Symbolleisten > Verändern , auf die Menüpunkte

• Auf Kreis setzen (perspektivisch) und
• Auf Kreis setzen (neigen).

Siehe auch Kapitel 4 - Objekteigenschaften ändern des Draw Handbuchs.
• Ist die Option nicht aktiv, dann ist das Verzerren zugelassen, das Objekt wird verzerrt.
• Ist die Option aktiv, dann behält das Objekt seine Form bei der Ausführung dieser 

Befehle bei, es wird dann nur gedreht oder verschoben.

Abbildung 3: Wirkung der Option "Objekte in Kurven nicht verzerren"

Abbildung 3 zeigt die Wirkung dieser Option auf eine Reihe von Quadraten. Sie werden 
gemeinsam markiert (nicht gruppiert!).

• Links ist die Option deaktiviert, das Verzerren ist also zugelassen, aus den Quadraten 
werden Kreissegmente.

• Rechts ist die Option aktiv, die einzelnen Objekt werden daher nicht verzerrt und 
behalten ihre Form.

Maßeinheit
Hier legen Sie die Maßeinheit fest, (siehe Auswahl in Abbildung 1 auf Seite 7), in der die 
Größe der Zeichnungsobjekte angegeben wird. Der Standardwert der Maßeinheit ist in der 
deutschsprachigen Version Zentimeter (cm), was in den meisten Fällen eine passende Wahl 
ist. Insbesondere wenn Sie Zeichnungen in einem anderen Maßstab anfertigen (siehe 
Skalierung (Zeichnungsmaßstab) auf Seite 11), dann kann auch eine andere Maßeinheit 
sinnvoll sein, selbst wenn Sie im metrischen System bleiben. Die interne Größeneinheit ist 
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auch bei nicht-metrischen Einheiten immer 1/100-tel Millimeter. Nur mit der Einstellung mm 
sehen Sie die Werte in voller Genauigkeit.
Diese Wahl beeinflusst zunächst auch die Größenangabe in den Linealen, sie können diese 
aber separat einstellen (siehe Kapitel 1 – Einführung in Draw des Draw Handbuchs).

Tabulatoren
Mit dieser Einstellung, (siehe Auswahl in Abbildung 1 auf Seite 7), legen Sie den Standardab-
stand der Tabulatoren fest: wenn Sie in einem Text die Tabulator-Taste betätigen, wird die 
Position des folgenden Zeichens so weit nach rechts verschoben, dass sie auf dem nächsten 
Vielfachen dieses Wertes liegt.

Hinweis

Individuelle Tabulatoren-Abstände können Sie für einzelne Absätze oder in 
Formatvorlagen festlegen.

Skalierung (Zeichnungsmaßstab)
Der Maßstab definiert das Verhältnis zwischen der Größe des Zeichnungsobjekts und der 
tatsächlichen Größe des dargestellten Objekts. Die Standardeinstellung ist 1:1, das heißt, 
das Zeichnungsobjekt ist genauso groß wie das dargestellte Objekt; bei Darstellung von 
Grundrissen von Räumen wird man vielleicht einen Maßstab von 1:10 wählen, für größere 
Gebäude eher 1:100. Im letzteren Fall sind die dargestellten Objekte in der Realität hundert 
Mal so groß wie in der Zeichnung.

Kompatibilität

Druckermaße für Textformatierung verwenden
LibreOffice versucht, das ganze Layout druckerunabhängig zu halten. Es gibt jedoch ältere 
ODF-Formatversionen, die das nicht tun. Wenn Sie ein solches Dokument laden, wird die 
Option gesetzt, Sie können sie dann aber ausschalten

Textobjekte

Schnellbearbeitung zulassen
Dies ist in Schnellbearbeitung auf Seite 8 beschrieben.

Nur Textbereich auswählbar
Hat ein Textfeld keine Füllung, dann ist ein hinter diesem Textfeld liegendes anderes Objekt 
sichtbar. Das Textfeld kann allerdings größer sein als der Text, was man in diesem Fall gar 
nicht sieht (außer an einer eventuell vorhandenen Umrandung), wie im linken Teil der Abbil-
dung 4 sichtbar.
Ist die Option Nur Textbereich auswählen deaktiviert, dann selektiert ein Klick auf die sicht-
bare Fläche des zweiten Objekts das dieses überdeckende Textfeld, wie im linken Teil der 
Abbildung zu sehen ist.
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Abbildung 4: Nur Textbereich auswählen: links deaktiviert, rechts aktiviert

Ist die Option dagegen aktiviert, dann wird bei einem Klick auf das Rechteck dieses 
aktiviert, sofern sich nicht an der Stelle des Klicks auch Text des Textfeld befindet. Die Selek-
tion nach dem Klick zeigt der rechte Teil der Abbildung 4. Will man das Textfeld selektieren, 
muss man also in den Bereich des Textfeldes aber außerhalb des Rechtecks klicken.

Optionen - Ansicht
Abbildung 5 zeigt die Möglichkeiten für diese Wahl der Optionen.

Abbildung 5: Optionen > LibreOffice Draw > Ansicht

Anzeige

Lineale sichtbar
Mit dieser Option (siehe Abbildung 5) können Sie die Lineale, die am linken und oberen Rand 
der Arbeitsfläche angezeigt werden, ein- und ausschalten.

Hinweis

Sie können die Lineale auch über Ansicht > Lineale oder Strg+Umschalt+R ein- 
und ausschalten.

Hilfslinien beim Bewegen
Hier (siehe Abbildung 5) können Sie festlegen, ob die Hilfslinien beim Bewegen (siehe den 
Abschnitt Raster, Hilfs- und Fanglinien in Kapitel 1 – Einführung in Draw des Draw 
Handbuchs) angezeigt werden oder nicht. Diese Option steht unter dem Namen Hilfslinien 
beim Verschieben auch über Ansicht > Raster und in der Symbolleiste Standard zur 
Verfügung.
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Alle Steuerpunkte im Bézier-Editor
Siehe Abbildung 5.Bézierkurven und eventuell auch Vielfachlinien/Polygone besitzen 
sogenannte Steuerpunkte, mit denen die Form der Verbindung zwischen zwei Eckziehpunk-
ten des Objekts beeinflusst werden kann (siehe den Abschnitt Bézierkurven und Polygone in 
Kapitel 11 – Fortgeschrittene Zeichentechniken des Draw Handbuchs. Wenn die Option 
deaktiviert ist, werden nur die Steuerpunkte angezeigt, die zum gerade ausgewählten 
Eckziehpunkt gehören; ist sie aktiviert, werden die Steuerpunkte zu allen Eckziehpunkten 
aller ausgewählten Objekte angezeigt.

Hinweis

Beachten Sie, dass manche Steuerpunkte, wie im genannten Abschnitt geschil-
dert, direkt auf den Eckziehpunkten liegen können.

Umriss jedes einzelnen Objekts
Diese Option (siehe Abbildung 5) muss im Zusammenhang mit der Option Objekt mit Attri-
buten ändern der Symbolleiste Optionen betrachtet werden, sie hat keine Wirkung, wenn in 
der Symbolleiste Optionen – das Symbol Objekt mit Attributen ändern gesetzt ist.

Abbildung 6: Die Optionen „Objekt mit Attributen ändern“ und „Umriss jeden einzelnen Objekts“

Symbolleiste Optionen - Symbol
Objekt mit Attributen ändern

Menü Optionen > LibreOffice Draw > Ansicht
Umriss jeden einzelnen Objekts

1 Aus Aus
3 Aus Ein

2+4 Ein Ein oder Aus (nicht relevant)

Abbildung 6 zeigt die unterschiedlichen Möglichkeiten:
• 1 - ist bei deaktivierter Option Objekt mit Attributen ändern auch die Option Umriss 

jedes einzelnen Objekts ausgeschaltet: es wird beim Verschieben nur ein Rahmen 
gezeichnet.

• 3 - ist die Option Objekt mit Attributen ändern ausgeschaltet und die Option Umriss 
jedes einzelnen Objekts eingeschaltet: dann wird nur der Umriss der verschobenen 
Objekte gezeichnet.

• 2+4 - ist die Option Objekt mit Attributen ändern aktiviert (was der Standard ist): 
beim Verschieben wird zu jedem Objekt ein Phantombild in blasserer Farbe 
gezeichnet
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Optionen - Raster
Siehe hierzu auch Symbolleiste Optionen auf Seite 23.
Abbildung 7 zeigt die bei dieser Wahl verfügbaren Optionen.

Abbildung 7: Optionen > LibreOffice Draw > Raster

Raster
Als Hilfsmittel zum Platzieren von Objekten bietet Draw ein Raster an, das aus den Schnitt-
punkten von gedachten waagrechten und senkrechten Linien besteht. Abbildung 8 zeigt 
vergrößert in schwarzer Farbe die Rasterpunkte, wie sie in Abbildung 7 ausgewählt sind. Das 
Raster ist dann nur angedeutet.
An jedem Rasterpunkt kann – wenn Sie das so eingestellt haben – ein Objektpunkt (siehe 
Kapitel 3 – Objekte und Objektpunkte des Draw Handbuchs) einrasten.
Die Farbe des Rasters können Sie über Extras > Optionen… > LibreOffice > Anwendungs-
farben im Abschnitt Zeichnung / Präsentation verändern.
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Abbildung 8: Raster

Die weiteren Einflussmöglichkeiten werden im Folgenden vorgestellt.

Am Raster fangen
In Abbildung 7 (auf Seite 14) stellen Sie ein, ob das Raster überhaupt verwendet werden soll, 
um Zeichnungsobjekte zu „fangen“. Diese Einstellung steht auch über das Menü Ansicht > 
Fanglinien > Am Raster fangen zur Verfügung Abbildung 9.

Abbildung 9: Menü Ansicht > .....

Raster sichtbar
Steuert, ob das genannte Raster angezeigt wird oder nicht (Abbildung 7 auf Seite 14). Die 
Fangfunktion ist aber, wenn Sie sie aktiviert haben, auch bei ausgeschalteter Anzeige aktiv. 
Diese Einstellung steht auch über das Menü Ansicht > Raster > Raster sichtbar sowie in der 
Symbolleiste Standard mit dem Symbol Raster anzeigen zur Verfügung.

Auflösung
Die Auflösung (Abbildung 7 auf Seite 14) legt die Dichte des Rasters fest. Mit den Werten in 
Horizontal und Vertikal bestimmen Sie in waagrechter und senkrechter Richtung die 
Grobeinteilung des Rasters, im Beispiel in Abbildung 8 auf Seite 15 die fetteren schwarzen 
Punkte im Abstand von 1 cm.
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Wenn Sie Achsen synchronisieren aktiviert haben, ändern sich beide Werte immer synchron. 
Dies gilt auch für die im nächsten Abschnitt besprochenen Unterteilung.

Unterteilung
Mit dieser Angabe (Abbildung 7 auf Seite 14) definieren Sie, in wie viele Teile das grobe 
Raster, das im vorigen Abschnitt Auflösung festgelegt wurde, unterteilt werden soll. 
Während bei Maßeinheiten des Dezimalsystems der Standard einer Unterteilung in zehn 
Einheiten angemessen ist, können bei anderen Maßeinheiten (siehe Maßeinheit auf Seite 10) 
andere Einteilungen sinnvoll sein. Für die Einheit Zoll sind beispielsweise neben der Untertei-
lung in 10 Abschnitte auch solche in 12 oder 8 und höhere Zweierpotenzen üblich.

Fangen
Neben dem Fangen an den Rasterpunkten sind auch andere Fangmethoden möglich, 
siehe Abbildung 7 auf Seite 14:

• An Fanglinien
• An den Seitenrändern
• Am Objektrahmen
• An Objektpunkten

auswählbar. (siehe Kapitel 3 – Objekte und Objektpunkte des Draw Handbuchs). In diesem 
Abschnitt legen Sie fest, welche Optionen für das Fangen aktiviert sein sollen. Aktivieren Sie 
nicht unbedingt allzu viele dieser Optionen gleichzeitig und ändern Sie die Auswahl bei 
Bedarf auch einmal, denn die verschiedenen Optionen können sich eventuell auch in die 
Quere kommen. Die Möglichkeiten stehen auch über das Menü Ansicht > Fanglinien zur 
Verfügung (Abbildung 9).
Der als Standard eingestellte Fangbereich von 5 Pixel ist so klein, dass das Einrasten beim 
Zeichnen nur schwer zu beobachten ist, am besten sehen Sie die Wirkung, wenn Sie einen 
eingerasteten Objektpunkt verschieben: er „klebt“ zunächst an seiner Stelle, bis Sie die 
Maus weit genug von dieser Stelle entfernt haben. Dies gilt nicht nur dann, wenn der 
Endpunkt an einem anderen Objekt eingerastet ist, sondern auch in Bezug auf den bisheri-
gen Ort dieses Endpunkts, Sie müssen ihn entsprechend weit verschieben, bevor er sich 
bewegt. Stellen Sie den Fangbereich also auch nicht zu groß ein!

Objekte beschränken
Abbildung 7 auf Seite 14, mit diesen Optionen können Sie das Verhalten von Draw beim 
Einfügen und Verändern von Zeichnungsobjekten beeinflussen (Abbildung 7 auf Seite 14).

Beim Erzeugen und Bewegen
Wenn Sie bei den Aktionen zusätzlich die  Umschalt-Taste gedrückt halten, wird das Gegen-
teil bewirkt.

Beim Erzeugen und Bewegen nicht aktiviert
Siehe Abbildung 7 auf Seite 14. Die Standardeinstellung von LibreOffice ist, dass Sie Größen-
änderungen in waagrechter und senkrechter Richtung unabhängig voneinander vornehmen 
beziehungsweise ein neues Objekt dementsprechend in beiden Richtungen unabhängig 
voneinander zeichnen können.
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Beim Erzeugen und Bewegen aktiviert
Das Standardverhalten können Sie umkehren, indem Sie die Option Beim Erzeugen und 
Bewegen aktivieren. Es wird in beiden Richtungen synchron gezeichnet.

Längere Kantenlänge
Wenn Sie bei den Aktionen zusätzlich die  Umschalt-Taste gedrückt halten, wird das Gegen-
teil bewirkt.
Die Längere Kantenlänge ist bezieht sich auf den Abstand des Objekts der linken oberen 
Ecke zum Mauscursor. Diese Option ist nur wirksam, wenn die Option Beim Erzeugen und 
Bewegen (siehe Seite 16) aktiv ist.
Siehe Abbildung 7 auf Seite 14. Wenn also die Einstellung Beim Erzeugen und Bewegen 
aktiviert ist, sind die Größenänderungen in beiden Richtungen synchron. Beim Zeichnen 
eines neuen Objekts stellt sich nun die Frage, wie auf die Position des Mauszeigers reagiert 
werden soll, der ja normalerweise in Bezug zum Anfangspunkt nicht ein Quadrat definiert, 
was der festgelegten Beschränkung entspräche. Es muss entschieden werden, welche der 
beiden Entfernungen – in x- oder y-Richtung – nun für das Zeichnen herangezogen wird. 
Wenn für die Längere Kantenlänge ein Häkchen gesetzt ist, wird die größere Entfernung von 
der linken oberen Ecke zum Mauszeiger verwendet. Das bedeutet, dass die längere Kanten-
länge des aufgezogenen Rechtecks die Größe der Form bestimmt (Abbildung 10  aktiviert).

Abbildung 10: Längere Kantenlänge - 
a) deaktiviert
b) aktiviert

Abbildung 11  zeigt dies am Beispiel zweier Quadrate (aufgrund der Beschränkungen werden 
ja keine Rechtecke gezeichnet):

• links ist die Option Längere Kantenlänge deaktiviert, der Mauszeiger legt die Größe 
des Quadrats anhand der kürzeren Entfernung zum linken oberen Eckpunkt fest.

• rechts die fast gleiche Situation bei aktivierter Option Längere Kantenlänge: die 
Entfernung des Mauszeigers vom linken oberen Eckpunkt in y-Richtung bestimmt die 
Größe des Quadrats.
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Abbildung 11: Längere Kantenlänge deaktiviert (links) und aktiviert (rechts)

Beim Drehen
Hier (siehe Abbildung 7 auf Seite 14) können Sie einstellen, welcher Winkel bzw. dessen 
Vielfache beim Drehen automatisch angewendet werden sollen. Die Standardeinstellung ist 
15°, was einer Unterteilung des rechten Winkels in sechs Richtungen entspricht. Beachten 
Sie dabei, dass diese Einstellung relativ zu einem bereits vorhandenen Drehwinkel eines 
Objekts wirkt: ist das Objekt bereits um 4° gedreht, dann wird es bei aktivierter Option mit 
dem Standardwert 15° um diesen Wert gedreht und hat dann eine Drehung von 19°.

Punktreduktion
Hier (siehe Abbildung 7 auf Seite 14) legen Sie den Winkel fest, ab dem eine Punktreduktion 
erfolgen soll. Dies betrifft das Bewegen von Punkten eines Polygons bzw. einer Vielfachlinie, 
wenn sie sich dadurch der Verbindungslinie zwischen ihren Nachbarpunkten nähern; die 
genaue Beschreibung finden Sie in Kapitel 11 – Fortgeschrittene Zeichentechniken des Draw 
Handbuchs.

Optionen - Drucken
Diese Optionen sind hauptsächlich für Impress relevant, das ja viele Funktionen mit Draw 
teilt, da es auf diesem aufbaut; dieser Dialog sieht für Impress genauso aus.
Diese Optionen gelten für das einzelne Dokument, bei dem Sie sie setzen.
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Abbildung 12: Optionen > LibreOffice Draw > Drucken

Seitenoptionen
Die meisten dieser Einstellungen dienen als Vorschlagswerte für den Druckdialog und 
können beim Drucken überschrieben werden.

Standard
Die Seiten werden beim Drucken nicht skaliert. Die Seite wird links oben auf dem Papier 
platziert. Ist die Seite zu groß für das Papier, wird sie abgeschnitten.

An Seitengröße anpassen
Hat die Seite ein anderes Format als die bedruckbare Seite, so wird die Größe der Zeichnung 
angepasst, damit sie vollständig auf die Druckseite passt.

Seiten kacheln
Sind die Seiten deutlich kleiner als das Papier, wird mehrfach auf ein Blatt gedruckt. Hat das 
Dokument mehrere Seiten, wird auf das nächste Blatt die nächste Seite gedruckt.

Hinweis
Die beiden vorigen Einstellungen funktionieren nicht korrekt, wenn die Orientierung von 
Seite und Papier unterschiedlich ist, siehe:
tdf#131131 - PRINTING Paper orientation is forced to document orientation in "tiled" and 
"fit".

Broschüre
Diese Option ermöglicht Ihnen, eine Datei mit vielen Seiten im Broschürenformat auszudru-
cken. Es bedeutet, dass jede Seite der Datei auf eine halbe Druckseite im Querformat 
abgebildet wird. Dabei werden die gedruckten Seiten so angeordnet, dass die Ausdrucke 
dann in der Mitte geheftet werden können und in der sich dann ergebenden Reihenfolge 
beim Blättern richtig sortiert sind. Die Seiten werden dabei, wenn nötig, verkleinert.
Abbildung 13 zeigt das an dem einfachen Beispiel einer Datei, die vier Seiten enthält, die 
jeweils die Seitennummer in sehr großer Darstellung zeigen. Beim Broschürendruck wurden 
sowohl Vorderseite wie auch Rückseite ausgewählt, das heißt es wurde ein zweiseitiger 
Druck angestrebt. Die linke Hälfte der Abbildung zeigt nun die Vorderseite des Papiers, die 
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rechte Hälfte die Rückseite. Wenn man das Papier an der gestrichelten Linie faltet – heften 
ist bei einem Blatt noch nicht nötig – dann  kann man die Blätter in der Reihenfolge 1 – 2 – 3 
– 4 lesen.

Abbildung 13: Broschürendruck

Papierschacht aus Drucker-Einstellung
Legt fest, dass der zu benutzende Papierschacht derjenige ist, der in den Druckereinstellun-
gen festgelegt ist.

Qualität
Sie können festlegen, in welcher Qualität die Farben des Dokuments ausgedruckt werden 
sollen:

Standard
Die Farben werden wie vorhanden ausgedruckt

Graustufen
Die Farben werden in Graustufen umgewandelt.

Schwarzweiß
Die Farben werden in Schwarz oder Weiß umgewandelt. Farbverläufe werden durch Weiß 
ersetzt.

Drucken
Sie können getrennt festlegen, ob Seitenname, Datum und Uhrzeit mitgedruckt werden 
sollen. Der Ausdruck erfolgt links oben am Rand in der Form (Abbildung 14):

Abbildung 14: Beispiel mit Seitenname, Datum und Uhrzeit

Die Auswahl, ob Ausgeblendete Seiten gedruckt werden sollen, ist wirkungslos, da es in Draw 
nicht möglich ist, Seiten auszublenden. Das ist eine Option für Impress, mit der man Präsen-
tationen für gewisse Zwecke verkürzen kann.
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Startbildschirm

Draw Startbildschirm mit Legende

Abbildung 15: Draw Startbildschirm mit Legende
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Seitenleiste

Draw Seitenleiste mit Legende

Abbildung 16: Draw Seitenleiste mit Legende
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Symbolleiste Optionen

Draw Symbolleiste Optionen mit Legende

Abbildung 17: Symbolleiste Optionen mit Legende

Symbolleiste Optionen - Sichtbare Schaltflächen

Abbildung 18: Symbolleiste Optionen 
- Sichtbare Schaltflächen
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Weitere Informationen

Handbücher der LibreOffice Community
Die Handbücher für die einzelnen Anwendungen bestehen aus mehreren Kapiteln. Die 
Kapitelübersichten finden Sie auf der Webseite von LibreOffice - The Document Foundation
LibreOffice Handbücher (auf deutsch) / https://tdf.io/dedocs
LibreOffice Handbücher (englische Versionen) / 
https://wiki.documentfoundation.org/Documentation/Publications
LibreOffice bietet sechs Anwendungen (Komponenten) für die Erstellung und Bearbeitung
von Dokumenten und zur Datenverarbeitung:

• Writer - Textverarbeitung
• Calc - Tabellenkalkulation
• Impress - Präsentationen
• Draw - Zeichnungen
• Base - Datenbanken
• Math - Formeleditor

Die Kapitel
Jeder, der sich schnell mit LibreOffice vertraut machen möchte, wird die Kapitel zu schätzen 
wissen. Vielleicht sind Sie neu in der LibreOffice Suite oder Sie sind mit eine anderen Office-
Suite vertraut. Die Kapitel von LibreOffice bieten Ihnen themengenaue Informationen.

PDF-Versionen
Alle Kapitel können frei als PDF-Version heruntergeladen werden:
LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

Die Autoren
Die Handbücher werden von Freiwilligen der LibreOffice-Community erstellt.

Über LibreOffice
LibreOffice ist eine leistungsfähige Office-Suite, für verbreitete Betriebssysteme wie 
Windows, GNU/Linux 32-/64-Bit und Apple Mac OS X geeignet.
LibreOffice entsteht aus der kreativen Zusammenarbeit von Entwicklern und der 
Gemeinschaft der Stiftung The Document Foundation / 
https://de.libreoffice.org/about-us/governance/. Die Stiftung hat ihren Sitz in Berlin / 
Deutschland.
Das Programm LibreOffice kann unter der Adresse LibreOffice Download / 
https://de.libreoffice.org/download/download/ kostenlos heruntergeladen werden.
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Kapitelübersicht - Draw Handbuch
Kapitel 1 - Einführung in Draw
Kapitel 2 - Zeichnen von Formen
Kapitel 3 - Objekten und Objektpunkte
Kapitel 4 - Objekteigenschaften ändern
Kapitel 5 - Mehrere Objekte
Kapitel 6 - Bilder bearbeiten (Rasterbilder)
Kapitel 7 - Arbeiten mit 3D Objekten
Kapitel 8 - Verbinder, Fluss- und Organisationsdiagramme
Kapitel 9 - Text einfügen und formatieren
Kapitel 10 - Drucken, Exportieren, E-Mailen
Kapitel 11 - Fortgeschrittene Zeichentechniken
Anhang B – Extras > Optionen
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Hilfe
So verwenden Sie die Hilfe von LibreOffice.

Offline-Hilfe
Die Offline-Hilfe steht Ihnen nur zur Verfügung, wenn Sie sie auch installiert haben.
Platzieren Sie den Cursor an eine Stelle (Menü, Dialog etc.), an der Sie Hilfe benötigen.
Betätigen Sie die Taste F1, (bei Laptops evtl. Fn+F1).

Online-Hilfe
Die Online-Hilfe wird Ihnen angeboten, wenn Sie keine Offline-Hilfe installiert haben.
Sie können die Online-Hilfe aber auch direkt in Ihrem Internetbrowser öffnen:
LibreOffice online Hilfe

Offline- und Online-Hilfe
Beide Hilfesysteme öffnen sich jeweils in Ihrem als Standard festgelegten Internetbrowser.
Im oberen Bereich befindet sich die Suchleiste. Dort können Sie Ihre Suchbegriffe eingeben. 
Schon bei der Eingabe eines Buchstabens bekommen Sie direkt darunter eine Auswahl von 
Themen. Mit jedem weiterem Buchstaben konkretisiert sich die Auswahl.
Klicken Sie dann in die Auswahl auf ein Thema, um die Beschreibung dazu im mittleren 
Bereich des Fenster zu lesen.

Noch Fragen?
Für Fragen zum Thema gehen Sie zu Ask.LibreOffice:
Fragen auf ask.LibreOffice

Mitarbeit bei LibreOffice
Besuchen Sie uns auch auf der Seite Dabei sein!:
LibreOffice Community

Spenden
LibreOffice ist freie Software und wird kostenfrei zur Verfügung gestellt. Ihre Spende, die 
rein freiwillig ist, unterstützt unsere weltweite Gemeinschaft. Wenn Ihnen die Software 
gefällt, freuen wir uns über eine Spende auf Spenden für die Document Foundation.

Weitere Informationen 26

https://de.libreoffice.org/donate/
https://de.libreoffice.org/community/get-involved/
https://ask.libreoffice.org/
https://help.libreoffice.org/latest/de/text/shared/05/new_help.html

	Inhalt und Allgemeines
	Copyright
	Mitwirkende/Autoren
	Englisches Originaldokument
	Rückmeldung
	Datum der Veröffentlichung und Softwareversion
	Verwendung von LibreOffice unter macOS
	Synonyme
	Sie sehen vielleicht etwas anderes
	Querverweise hier im Dokument
	Links zu externen Quellen

	Einführung
	Die Optionen zur Objektbearbeitung
	Für Textobjekte
	Schnellbearbeitung
	Text bearbeiten bei Doppelklick

	Drehmodus

	Optionen - Allgemein
	Einstellungen
	Kopie beim Verschieben
	Hintergrundzwischenspeicher verwenden
	Objekte immer verschiebbar
	Objekte in Kurven nicht verzerren
	Maßeinheit
	Tabulatoren

	Skalierung (Zeichnungsmaßstab)
	Kompatibilität
	Druckermaße für Textformatierung verwenden

	Textobjekte
	Schnellbearbeitung zulassen
	Nur Textbereich auswählbar


	Optionen - Ansicht
	Anzeige
	Lineale sichtbar
	Hilfslinien beim Bewegen
	Alle Steuerpunkte im Bézier-Editor
	Umriss jedes einzelnen Objekts


	Optionen - Raster
	Raster
	Am Raster fangen
	Raster sichtbar

	Auflösung
	Unterteilung
	Fangen
	Objekte beschränken
	Beim Erzeugen und Bewegen
	Beim Erzeugen und Bewegen nicht aktiviert
	Beim Erzeugen und Bewegen aktiviert

	Längere Kantenlänge
	Beim Drehen
	Punktreduktion


	Optionen - Drucken
	Seitenoptionen
	Standard
	An Seitengröße anpassen
	Seiten kacheln
	Broschüre
	Papierschacht aus Drucker-Einstellung

	Qualität
	Standard
	Graustufen
	Schwarzweiß

	Drucken

	Startbildschirm
	Draw Startbildschirm mit Legende

	Seitenleiste
	Draw Seitenleiste mit Legende

	Symbolleiste Optionen
	Draw Symbolleiste Optionen mit Legende
	Symbolleiste Optionen - Sichtbare Schaltflächen

	Weitere Informationen
	Handbücher der LibreOffice Community
	Die Kapitel
	PDF-Versionen

	Die Autoren
	Über LibreOffice

	Kapitelübersicht - Draw Handbuch
	Hilfe
	Offline-Hilfe
	Online-Hilfe
	Offline- und Online-Hilfe

	Noch Fragen?
	Mitarbeit bei LibreOffice
	Spenden


